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Using the Mouse for Note Input 
1. Select a Time Signature (on the Options Menu). 

Legal range is from 2/2 to 16/16.
2. Select a Beat Division by pressing a number key on the numeric keypad (Num Lock must be 

on) 1 - 9.

This procedure selects the smallest notevalue to be entered and is indicated on the Ruler.
Beat division can be changed anytime.

For a higher division than 9, select '0' for the Ruler New subdivision dialog box:

3. Select the note pointer by pressing the  on the Toolbar
4. Move the Pointer to the Staff and position where you want the note(s) to start. 
The Cursor on the Ruler shows the current position.
5. Click the left mouse button and drag to enter the note.
The Cursor on the Ruler shows the note's end position.
· For Sharps - press 's' before releasing the mouse button.
· For Flats - press 'f' before releasing the mouse button.
· For Double Sharps - press 'S' before releasing the mouse button.
· For Double flats - press 'F' before releasing the mouse button.



Preparing for Step Input from MIDI Instrument
1. Select MIDI IN = ON by pressing the MIDI IN Enable button on the Toolbar.

2. Select a Time Signature (on the Options Menu). 
Legal range is from 2/2 to 16/16.

3. Select a Beat Division by pressing a number key on the numeric keypad (Num Lock must be 
on) 1 - 9.

This procedure selects the smallest notevalue to be entered and is indicated on the Ruler.
Beat division can be changed anytime.

For a higher division than 9, select '0' for the Ruler New subdivision dialog box:

4. Move the Ruler to the Staff and position where you want the note(s) to start.

5. Press and release one or several notes on the MIDI instrument.
The Cursor on the Ruler advances automatically when a note or chord is released.

Related Topics:
Entering notes longer than the current Subdivision:
Tied Notes
Voices



Entering notes longer than the current Subdivision:
· Step on the Sustain pedal on your instrument before releasing the notes. 

Each step makes the notes one subdivision longer

or

· Press the Right Arrow key before releasing the notes. 
Each press makes the notes one subdivision longer.



Tied Notes
· Tied Notes are automatic only. 

· It is not possible to tie two existing notes.

If you have two notes you want to tie, just delete the second note and make the first note longer. The Roll 
View Window is great for this type of editing.
Note that the Transcribe button must be checked when you want the notation to change.



Voices
For entry of polyphonic music open the Voice Control Toolbox and assign a voice and a stem direction 
before entering notes.



Preparing for Real-time Record
Basic

1. Select MIDI IN = ON by pressing the MIDI IN Enable button on the Toolbar.

2. Move the Ruler to the Staff and Bar where you want the note(s) to start.

3. Press the Record button to start recording.

4. Stop recording by pressing the Space bar, or by clicking the Stop button on the Toolbar.

Options
· Select a Time Signature (on the Options Menu). 

Legal range is from 2/2 to 16/16.

· Select a Beat Division by pressing a number key on the numeric keypad (Num Lock must be on) 
1 - 9.

This procedure selects the smallest notevalue to be entered and is indicated on the Ruler.
Beat division can be changed anytime.

For a higher division than 9, select '0' for the Ruler New subdivision dialog box:

· Select a tempo by pressing the button on the Toolbar

· Press the Metronome button on the Toolbar to activate the metronome.
Metronome settings can be changed by selecting "Metronome" on the Options Menu.

· If you prefer using a drum track instead of the metronome, step-input a drum pattern first and 
copy it the number of bars you like in Overview.



Playback Parameters 
These parameters and settings changes how the music plays:

Related Topics:
Note Parameters
Track/Channel settings
Instrument
Benders, Controllers
Transformations
Transpose
Mixer



Note Parameters 
· Attack Offset - Controls the timing of the note attack

· Release Offset - Controls the timing of the note release

· Key Velocity - Controls the loudness of a note

For individual notes, these parameters can be adjusted in the Roll View Window.



Track/Channel settings
The MIDI output from playing the score is controlled by the Channel, Mute and Transpose settings 
on the Part Setup menu.



Instrument
The instrument selected for playback obviously changes the way the music sounds. To select an 
instrument from the list select Instrument on the Windows menu.

Pick an Instrument from the list and click to choose an instrument (a sound).



Benders, Controllers
These parameters affect Pitch, Channel Volume, Modulation, Aftertouch etc. in the playback.

All types of Controllers are edited in their respective Controller windows.

Bender has its own editing window, selected from the Windows - New - Bender menu.

All Other Controllers are edited in a general Controller window, where the parameter is selected within the
window.
This Controller window is selected from the Windows - New - Other Controllers menu.



Transformations
The following transformations affect MIDI playback:

Quantize MIDI Changes the timing of 
the notes.    If quantized 
100% the Music sounds 
exactly 'as written'. 

Shift Clock Moves the playback of 
the notes forward or 
backward in time. 

Key Velocity Changes the dynamics 
of the notes

Offset Quantize Moves every even note 
in a beat a number of 
ticks to create a 
shuffle/swing feel.

Transpose
Transpose is possible both in Notation and Playback only

Transpose the notation of course changes playback. 

TIP
If you want to write a score with transposed parts you can transpose the playback of those parts to the 
correct sounding pitch, with the Transpose settings on the Part Setup Menu



Mixer
The Mixer settings playback only. 

The movement of the faders and buttons are not recorded.

The settings (position of faders and buttons) on the mixer are saved with the song and included when 
exported to MIDI file format. 



Notation Parameters 
These parameters and settings changes how the music appears:

Related Topics:
Transcription resolution
One Voice
Minimize rests
Voice assignments
Transposition
Graphic Symbols



Transcription resolution
Transcription resolution is set by pressing a number key on the numeric keypad, representing the beat-
subdivision.

The subdivision is indicated on the Ruler:

For a higher division than 9, select '0' for the Ruler New subdivision dialog box:

Transcription resolution is involved in the following processes:

· When music is recorded in real time

· When music is recorded in step-time

· When a MIDI file is imported

· When a selected area is re-transcribed

· When Shift Clock processing is selected and the 'New Notation' box is checked

· When notes are selected or edited the Roll View Window and the 'Transcribe' box is checked.



One Voice
The One Voice command affects the selected notes in the Notation Window or the selected bars in the 
Overview Window.



Minimize rests
The Minimize Rest command affects the selected notes in the Notation Window or the selected bars in 
the Overview Window.



Voice assignments
Voice assignments in polyphony are done with the Voice Control Tools.



Transposition
The Transpose command on the Edit menu changes the notated pitches as well as accidentals in the 
selected bars.

Transposition of playback only is done from the Part Setup Menu



Graphic Symbols
Use the Graphic symbols tool on the Toolbar to enter gsaphic symbols.

As the name implies, the graphic symbols in the current release of Musicator GS has no MIDI playback 
functions assigned to them..

The transposing symbols (clefs, 8va etc.) transposes the written music, but the actual MIDI pitches 
remains.



Note Editing
Musicator offers a convenient way to copy and move groups of notes, using the mouse.

These functions are known as 'drag and drop' in many other Windows applications:

Related Topics:
Selecting notes
Copying the selected notes
Note Attributes
Note Spacing



Selecting notes
· Click the left mouse button and draw a box around the notes you want to select for copy or move.

· The selected area will be inverted.
Moving the Notes
· Point to a notehead in the selected area.

· Click and hold the left mouse button and move the notes to the new position, 
The horizontal position (Beat, sub-division) is indicated by the Cursor on the Ruler.
· Release the mouse button.
· The notes in the group are re-transcribed, referred to the placement of the selected note.

NOTE
If you do not point to a notehead the notes will not actually be moved.

A note must be selected when moving notes, else Musicator GS can not know what to place, and where...



Copying the selected notes
· Point to a notehead in the selected area.

· Press and hold the Ctrl key, click and hold the left mouse button and move the notes to the new 
position.

· Release the mouse button.

Options
· If you want the intervals in the copied notes to be restricted to the pitches in the current tonality, 

press 'T' (for Tonality) before releasing the mouse button.

The intervals will be adjusted by removing all accidentals in the copied notes.

This is practical when copying notes vertically, to create harmony, as well as keeping a copied phrase 
within the current tonality.

To set accidentals for the copied note(s):
· For Sharps - press 's' before releasing the mouse button.

· For Flats - press 'f' before releasing the mouse button.

· For Double Sharps - press 'S' before releasing the mouse button.

· For Double flats - press 'F' before releasing the mouse button.

The absolute intervals within the phrase are kept.



Note Attributes
Editing of note attributes is done with the Note Attributes Toolbox.

It can be selected from the Options Menu or by clicking the right mouse button.

It contains tools for:

· Grace notes, 

· Stem direction, 

· Enharmonic Transforms 

· Beam Grouping. 



Note Spacing
Note spacing can be controlled in two ways:

For Global Notation Display attributes set the Spacing parameter in the Options - Notation Mode dialog 
box.

Spacing can also be adjusted locally:

 

Click - Hold on a sub-division line on the Ruler, and drag slowly left or right.

The spacing between notes will change.



Rests

About Rests in Musicator GS
Musicator GS automatically generates the correct rests in the music, for each individual voice on the staff.

There are several tools available if you would like to manipulate the default rests and their placement:

Related Topics:
Moving rests
Hide/Show Rests
User defined rests



Moving rests
1. Rests can be moved freely within the bar.

2. Click+drag the mouse over the area with the rest to select.

3. Click and hold the mouse button.

4. Press 'R' 

5. Move the rest to the new position and release the mouse button.



Hide/Show Rests
Rests can be hidden if you want to de-emphasize polyphony.

The Transform menu contains commands to Hide Rests - and to Show hidden rests.



User defined rests
Rests are also available as pure graphical symbols - having no effect on the MIDI musical structure.

These rests are selected from the Graphic Symbols - User - menu, and can be put anywhere in the 
music.



Score Layout
Page Layout
Page layout parameters are available on the Options - Page Layout menu.

Instruments, margins, instrument name area length, separate size scaling for score and parts, titles and 
credits are set on this menu.

Instruments in the score 
Pressing the Instruments button on the Page Layout menu opens the selection window for parts and part 
placement in the score

Distance between staves

The distance between staves in the score are set in the Notation window with the  System 
Dimensions tool on the Toolbar.
Clefs
Initial Clefs are set in the Part Setup Menu.
Clefs can also be inserted anywhere in the score from the Symbols menu.
Transposition
Each staff can be individually transposed by selecting the track, with all bars, in the Overview Window.
Then select Transpose on the Transform menu.



Printing
Print Setup
Page Orientation
Print



Print Setup
All printing in Musicator GS is based on the settings in the Windows Print setup.

NOTE
· Print setup is global for the communication between Windows and the printer, and controls all 

print jobs from all applications.



Page Orientation
· If you want to print out the score in landscape format you will have to set print setup to landscape 

before printing score, then change to portrait before printing parts in portrait format.

· If you want to print both score and parts in the same format you can print both score and the 
selected parts in one print session.



Print
Both Score and all/selected Parts can be printed out in one unattended session if both score and parts 
are in the same page format.

The selection is done in the Print Preparation dialog box



File Menu
New
Opens a new blank file with the default settings of staves, channels etc.

Open
Opens a Musicator file, with the extension .MCT

The .MCT file format is unique to Musicator, and can not be read/created by other applications.

Musicator GS for Windows reads all earlier .MCT formats from older releases of Musicator for DOS. 

The Musicator GS for Windows file format can not be read by older releases of Musicator for DOS. 

Save
Saves the current song as a Musicator file, with the extension .MCT

Save as 
Prompts for a filename before saving.

Related Topics:
Export MIDI file
Import MIDI file
Print
Print Setup
Exit



Export MIDI file
Saves the current song as a MIDI file in Type 0 or Type 1 format.

These files can be read by practically all current MIDI-related applications.

Type 0 - Single track format (one track contains all MIDI channels)

Type 1 - Multi track format (several tracks, each can contain one or several MIDI channels)

Copyright Notice
If you want to include a Copyright Notice in the MIDI file, check the Copyright checkbox and type the 
notice in the text field.

System Exclusive
If you want to exclude SysEx messages in the exported MIDI file, check the SysEx box.

NOTE #1
Musicator GS exports all settings on the Mixer, Drums, Channel setup and Effects Control. 
These settings are exported as Control messages or, where applied, as System Exclusive messages.

These messages are numerous and take some time to transmit. To avoid interfering with the Note 
messages, all setting messages are placed in a bar preceding the actual music.

This is recommended in Roland's GS format specification.

A MIDI file exported from Musicator GS will therefore have one bar added in the beginning of the song.

NOTE # 2
At the time of writing, no other Windows sequencer program known to us reads embedded SysEx data in 
a MIDI file. They usually are discarded, but some programs may even lock up.
The Windows Media Player however, and MultiMedia authoring program, plays Musicator GS MIDI files 
as is.
This is also the case with most stand-alone MIDI file playback units, like the Roland SB-55 Sound Brush.

If you encounter problems, check the SysEx exclusive box before exporting the MIDI file.



Import MIDI file
Reads a MIDI file, Musicator GS transcribes the file while reading 

The current Beat-Resolution indicated on the Ruler determines the smallest note-value in the 
transcription.

The Time Signature(s) is read from the MIDI file.

Each MIDI Channel in the file is assigned to a staff. 

NOTE
If the MIDI file contains several tracks and a given channel exists in several of these tracks, all data on 
that given channel is assigned to the same staff in Musicator.

Like most MIDI performances, a MIDI file most likely will have to be edited for appearance when imported.
Some MIDI files are strictly quantized and will look good directly when transcribed. Others might be 
harder to read. 

TIP
Using the powerful One Voice and Minimize Rests commands on the whole song will make most 
published MIDI files look good with minimal editing effort.



Print
Both Score and all/selected Parts can be printed out in session.

Check the Score checkbox and the Part checkbox you want to print.

Page number offset
If you are printing a large work in several files, you might want to continue page numbering after the last 
page in the preceding section.

The Offset number will be the same as the number of pages printed in the preceding session.

Lead in bar
If you have a lead in bar in your song, type -1 as bar offset

Bar number offset
If you are printing a large work in several files, you might want to continue bar numbering after the last bar
in the preceding section.

The Offset number will be the same as the number of bars printed in the preceding session



.

Print range
Print range can be set to All or a range of Bars.

This setting affects both score and the selected parts.



Print Setup
All printing in Musicator GS is based on the settings in the Windows Print setup.

NOTE
· Print setup is global for the communication between Windows and the printer, and    controls all 

print jobs from all applications.

· If you want to print out the score in landscape format you will have to set print setup to landscape 
before printing score, then change to portrait before printing parts in portrait format.

· If you want to print both score and parts in portrait format you can print both score and the 
selected parts in one print session.



Exit 
Exits Musicator GS.



Edit Menu
Edit Menu options in the Notation window
Edit menu options in the Overview window
Edit menu options in the Controller window



Edit Menu options in the Notation window
In addition to the menu-based Cut/Copy/Paste functions, Musicator GS also has mouse-controlled 
Cut/Copy/Paste functions.

These are described in Topics - Note Editing.

Related Topics:
Cut
Copy
Paste



Cut 
Cuts the currently selected notes and pastes it to Musicator's internal Clipboard.

NOTE:
Only the data is cut, and the time-span they contain is replaced with rests. The underlying bar-structure is 
kept.



Copy 
Copies the currently selected notes and pastes it to Musicator's internal Clipboard.



Paste
Pastes the notes in Musicator's internal Clipboard to the current position where the cursor is placed.

NOTE:
Musicator has several internal clipboards, one for each window where data can be Cut/Copy/Pasted.
Cut/Copy and paste work only within the current Window.
Data cut from one window can not be pasted to a different window.

Example: 
If you copy a range of bars in the Overview window it can NOT be pasted directly to a position selected in 
the Notation window, or a Controller window etc.

Data on Musicator's Clipboard can not be pasted to other applications.

For transport of music data between applications see Import and Export MIDI file.



Edit menu options in the Overview window
Selecting bars and parts
Cut
Copy
Paste    Insert
Paste Merge
Paste Replace
Delete bars In Part(s)
Delete bars In Score
Insert bars In Part(s)
Insert bars In Score



Selecting bars and parts
To select a range of bars/parts, press the left mouse button and drag to cover the area you like. The 
selected area is inverted.

Selecting all bars in a part
To select all bars in a part, click on the name of that track.

Selecting all bars in several parts
To select all bars in several parts, press the left mouse button and drag down or up on the parts names 
you want to select.



Cut 
Cuts the data (notes and controllers) in the currently selected bars and pastes it to Musicator's internal 
Clipboard.

NOTE:
Only the data are cut, and the bar they are cut from becomes empty bars (with rests). The underlying bar-
structure is kept.



Copy 
Copies the data (notes and controllers) in the currently selected bars and pastes it to Musicator's internal 
Clipboard.



Paste    Insert 
The data (notes and controllers) and the bar(s) they reside in on the Clipboard is inserted in the selected 
track(s).    

The bar(s) in all track(s) are moved toward the end to give room for the inserted bar(s).



Paste Merge 
The bars and data on the Clipboard are merged (mixed) with the existing bars and data from the selected
bar.

No bars are inserted.



Paste Replace 
The bars and data on the clipboard replace the bars and data from the selected bar. 

The old data is erased.



Delete bars In Part(s)
The bars and the data in the selected bars are deleted and the remaining bars are moved forward. 



Delete bars In Score 
The bars and the data in the selected bars are deleted in the score (all channels), and the remaining bars 
are moved forward. 



Insert bars In Part(s) 
The number of bars in the selected bar range are inserted and the remaining bars are moved backward. 



Insert bars In Score
The bars in the selected bar range are inserted in the score (all channels), and the remaining bars are 
moved backward. 

NOTE
You can not have bars with different time signatures in tracks with the same bar number, such as 
a 3/4 in bar number 10 on the Trumpet track when bar number 10 on the other tracks is 4/4. 
All tracks share the same time signatures.
Time signatures can be changed anywhere, but are global, for all tracks in the score.



Edit menu options in the Controller window
Cut
Copies the data in the selected range to the Clipboard

Copy
Cuts the data in the selected range to the Clipboard

Paste
Pastes the data in the Clipboard to the current position.

To paste controller data:

1. First lock the cursor to the desired position by clicking on that point on the Ruler. 

2. Select Paste.

Clicking the Ruler again releases the cursor.

TIP
Controller data can be freely pasted between different types of Controllers.

If you want to make Filter Cutoff changes to follow the Bender,    copy the Bender data and paste it to the 
GS Filter Cutoff Controller window.

Even if Bender data in fact has a 14-bit range and are displayed by Musicator GS in cents, and all other 
controllers are 7-bit, Musicator GS features automatic conversion between the formats. 



Transform Menu options in the Notation Window
The Transform Menu contains commands that transform the selected data by processing the notation 
parameters or the MIDI data, or both.

Related Topics:
Transpose
Quantize MIDI
One Voice
Minimize Rests
Re-Transcribe
Shift Clock
Key Velocity
Rests



Transpose 
Opens the Transpose window. The selected area can be transposed up or down a number of semitones. 

Transpose in the Notation window is local, fixed accidentals are not changed.

Transpose in the Overview window affects a range of bars. 
Fixed accidentals are changed.



Quantize MIDI 
Musicator GS stores note events with two offsets: Attack offset and Release offset. A played note 
normally is hit and released at times earlier or later than the exact notevalue. These timings are called 
offsets in Musicator GS, and can be viewed as graphics and numbers in the Roll View Window:

The selected (highlighted) note shows an Attack offset of -6. This means that it starts 6 ticks earlier than 
written, the graphics confirms this showing that the note start is before the blue line indicating where the 
beat starts.

A positive Attack offset means that a note is played a little later than written.

The Release offset is similar, but specifies the release time of the note related to its exact, 'as written', 
values.

Quantization is specified in percentage where 100% is total quantization.
The score plays "as written" when both Attacks and Endpoints are quantized.

Setting another percentage reduces the attack offsets with that percentage, rounded off to the closest 
whole digit - 75% quantize of a note with an Attack offset of 31 ticks reduces the offset to 23 (even if the 
23.25 would be the exact value - fraction of ticks does not exist..)

Endpoint Quantize always sets release Offset to -8 ticks.

Quantize always adjusts the attack times, and optionally the Endpoints of the MIDI note events. 

Click in the checkbox to enable Endpoint quantize.

Related Topics:
Offset 8/16



Offset 8/16
Offset moves the attack time of notes on even subdivisions apart, creating a shuffle or swing feel. 

In certain styles it is hard to notate exactly how the music should be played.

For Shuffle and Swing grooves in certain tempo ranges it sounds better to let Musicator GS adjust the 
even notes with an accent offset. Notating as syncopated or triplets sounds exaggerated.

Offset can only be applied to even 8th (Offset 8) and 16th (Offset 16) notes. 
The odd notes are left unchanged.

Example:
The even notes are shown in blue:



One Voice 
Removes 'excessive polyphony' caused by late release of successive notes.

Before:

After:

The MIDI data is not affected, only the notation is changed.
OPERATION:

1. Select the area to be processed.

2. Select One Voice from the Transform menu - or press the  button on the Toolbar.

NOTE:
This operation is local. Use the One Voice command on the Transforms Menu on the Overview Window to
change multiple bars/tracks.



Minimize Rests 
Improves readability by transcribing notes followed by rests within a beat to a greater notevalue (= the 
note + the rests time).

Before:

After:

The MIDI data is not affected, only the notation is changed.
OPERATION:

1. Select the area to be processed.

2. Select Minimize Rests from the Transform menu - or press the  button on the Toolbar.

This operation is local. Use the Minimize Rests command on the Transforms Menu on the Overview 
Window to change multiple bars/tracks.



Re-Transcribe
Transcribes the MIDI data in the selected area with the current beat-resolution. 

Transcribing with a higher resolution shows more detail, but is harder to read. Transcribing with a lower 
resolution hides detail, but makes the notation more readable. 

OPERATION:
1. If you have recorded a performance containing triplets or other tuplets, select the areas where 

they occur. 

2. Change beat resolution, 

3. Select Re-transcribe or press the  button on the Toolbar. 
4. The notes will be re-transcribed to the new resolution.

TIP
If Re-transcription with various resolutions do not seem to fit, or if you are in doubt which resolution to 
choose, open the Roll View Window.

When you change resolution with the number keys, the time-grid changes. Try different resolutions. When
you find the resolution where the vertical lines are closest to the note attacks in the phrase, you have the 
resolution that will give the best transcription.



Shift Clock 
Slides all MIDI note events in the selected area forward or backward by a number of ticks.

The Notation can optionally be re-transcribed.

A positive value makes the events play later
A negative value makes the events play earlier
The available range depends on the existing offsets of the notes in the selected range.

Max. total offset of a note is +/- 479 ticks.
If you get an "Out of Range" error message, Musicator GS will calculate the maximum value possible 
when pressing OK and put that value in the value field.

New Notation checkbox
Checking the box will re-transcribe the music after shifting the notes.

This is relevant if you want to move the music, both as played as well as written. 



Key Velocity 
Key velocity describes the loudness of each individual note, in a range from 1..127.

Musicator GS records Key Velocity both in Real time and Step time. When music is written using the 
mouse, all notes written default to a Key Velocity of 64.

Change key Velocity on individual notes in done in Roll View

For processing a selected range of notes or bars, Musicator offers 3 type of processing tools:

Related Topics:
Level shift
Compression
Expansion



Level shift 
Shifts the Key Velocity up or down by a specified amount. 

If the specified amount causes loud notes to exceed the loudest level allowed in MIDI - 127, you will be 
prompted for two alternatives:

1. Cut the value at 127 for these notes

2. Abort the operation to try again with a smaller value.



Compression 
This process causes the difference in loudness between the selected notes to decrease, by compressing 
the Key Velocities by a factor.

The factor can be set between 1..10 with two decimals, like 3.27, 4.58 etc. 

The higher the factor the less the difference in loudness.



Expansion 
This process causes the difference in loudness between the selected notes to increase, by expanding the
Key velocity by a factor.

The factor can be set between 1..10 with two decimals, like 3.27, 4.58 etc. 

The higher the factor the bigger the difference in loudness.

If the specified amount causes loud notes to exceed the loudest level allowed in MIDI - 127, you will be 
prompted for two alternatives:

1. Cut the value at 127 for these notes

2. Abort the operation to try again with a smaller value.



Rests
Musicator automatically generates the correct rests in the music, for each individual voice on the staff. 
You can move rests, hide rests and bring them back.

TIP
If you want to create your own pattern of rests in a bar, like in a lead-in bar, you can enter rests as graphic
symbols from the Symbols menu.

The rests are in the User section.

NOTE
These rests are graphic symbols and are edited as all other graphic symbols. The Rest commands do not
apply to these rests.

Related Topics:
Hide Rests
Show Rests



Hide Rests
Rests can be hidden by first marking the area containing the rests with the mouse: 

Select the Rests - Hide command to hide the rests.



Show Rests
Hidden Rests can be shown by marking the area containing the hidden rests with the mouse:

Then select the Rests - Show command.



Transform Menu options in the Overview Window
The options are the same as in the Transforms - Notation Window. 

The difference is that the selection they work on is based on a 
selected range of bars, instead of a selection of notes.
These options are different:
Related Topics:

Transpose
Fixed Accidentals



Transpose
When Transpose is done in Overview, the fixed accidentals are changed. 
When the number of steps is one or more octaves, fixed accidentals are not changed.

New accidentals are set related to the existing accidentals:

· If a staff in the key of D (2 #'s) is transposed 2 semitones together with a parallel staff in C, the 
staff in D will be transposed to E (4 #'s) and the staff in C to D (2 #'s).

· If a selected range contains several key signatures they will all be transposed the selected 
number of halftones, with new accidentals for each key range.

Chord symbols entered with the Chord Symbols tool are also transposed.



Fixed Accidentals

 

Fixed Accidentals works on the selected bars only. 
Check the # or b buttons and type the number of accidentals you like.
Musicator GS supports up to 6 accidentals.

New Steps
Setting Fixed Accidentals is normally done before music is written or recorded. Sometimes it is likely that 
you want to change fixed accidentals in existing music. 

For example:
· When importing a MIDI file

· When a recorded performance had key changes 

· When you are writing music and forget to set accidentals.

Checking the New Steps box (default) uses Musicator's smart algorithms to set the correct accidentals. 
This will result in a correct setting of accidentals in most cases. 

Sometimes, when writing music of tonal complexity, you might want to change accidentals in a section 
because the tonality gravitate to a specific key. 

If you have done enharmonic transforms and want to keep these, then un-check the New Steps 
box before pressing OK.



Transform Menu options in the Controller Windows
The Controller Window shows the controller events as a bar-graph.

Drawing
To draw controller data press the Right mouse button and draw the graph freely.

Editing
To select a range within a Controller window click the left mouse button,    drag and release.

The selected area is inverted.

Related Topics:
Clock Shift
Level shift
Compression
Expansion
Interpolate



Clock Shift
Moves the selected controller data a number of clock ticks forward or backward in time.



Level shift
Increases or decreases the values of the selected data a number of units.

If the specified amount causes loud notes to exceed the maximum value allowed in MIDI - 127 -, you will 
be prompted for two alternatives:

1. Cut the value at 127 for these notes

2. Abort the operation to try again with a smaller value.



Compression
Compresses the selected data by a factor between 1 - 10, related to the calculated average value of the 
selected range.



Expansion
Expands the selected data by a factor between 1 - 10, related to the calculated average value of the 
selected range.

If the specified amount causes loud notes to exceed the maximum value allowed in MIDI - 127 -, you will 
be prompted for two alternatives:

1. Cut the value at 127 for these notes

2. Abort the operation to try again with a smaller value.



Interpolate
Generates new controller events between existing ones within the selected area.

To create a smooth transition: 
1. Click the from, between and end values by using the right mouse button. 

2. Select the area containing these values.

3. Choose Interpolate, a resolution (density in range and time) and click OK. 

Musicator GS inserts new values between the existing ones along a smooth curve (a spline) going 
through the values first set.



Screen Menu
On the Screen Menu you define up to 6 parts to be shown in the Notation Window. 

The point with the screen setups is to assist during composing, to be able to view and edit a free selection
of voices for mutual reference.

The Screen setups do not affect the Instrument setup in Page View.
There are 3 setups available.

They can be freely edited by selecting Modify on the Screen menu.

The shortcut for switching between them is pressing Alt+1, Alt+2, Alt+3 respectively.



Windows Menu
Musicator GS has several windows available, presenting different views of the music, setup parameters 
and more.

Related Topics:
User 1,2,3,4
Save user configuration
NEW
Mixer
Effects
Instrument
Setup - Part
Setup - Channel
Setup - Drum



User 1,2,3,4
These are the window setups defined by the user (or Musicator GS' defaults if no changes has been 
made).

The implementation of User setups have been chosen instead of the standard Windows' Tile and 
Cascade. This because it gives the user easier and better control over the Musicator GS' environment 
than the standard Windows' Tile and Cascade which handles all windows as of equal importance

The windows selected from the NEW list, their size and position, can be stored in 
a user setup:

· Notation

· Roll View

· Tempo

· Bender

· Program Change

· Other Controllers 
The Control parameter is selected from the a list within the Controller Window

· Overview

· Page View

These elements are not stored in a user setup:

- Mixer

- Effects 

- Instrument

- Setups 



Save user configuration
Saves the modified window setups within Musicator GS. 

Saving to disk is done automatically when you exit Musicator GS. 

The settings are stored in the configuration file MUSIC.CNF along with other parameters.



NEW
Opens a list over windows that can be stored in a user setup:

Related Topics:
Notation
Roll view - Melodic Staves
Roll view - Drum staves
Drum Settings
Tempo
Bender
After Touch
Program Change
Other Controllers
Overview
Page View



Notation 
Notation is Musicator GS' main window.

The Notation window is the window where you enter, record and edit the music.

The Notation window can be configured in two modes - Normal and Fit window - from the Notation Mode 
in the Options menu.

The Notation window in Normal mode has the same relative horizontal width as the printed score. 
This is the mode to use when preparing a score.

The horizontal proportions between Notes in Fit Window mode is stretched to fit within the sides in the 
window regardless of its width. This mode, with Time proportional notation, in combination with Roll View 
and Controller View of the same width, offers a unique overview of the voices, the MIDI note events and 
the controllers.





Roll view - Melodic Staves

Roll View shows MIDI note events in a Pitch/Time Grid.

The time grid is determined by the current beat-resolution, and is changed by pressing the number keys. 

The Roll view Time Grid and the Ruler are linked and always shows the same resolution.

The number of bars in Roll View is the same as set in the Notation Mode - Fit Window.

Roll View offer note entry and editing of note parameters using the mouse:

Note entry
Press Shift and click with the left mouse button in the beat and position you want the note placed.

When the mouse button is released the note is played for confirmation.

The note parameters defaults to:

· Length Current beat-division - 8 ticks

· Attack offset 0

· Release offset -8

· Velocity 64

If you move the note while pressing the left mouse button, the note is triggered when the pitch is changed.

Deleting a note
Click on a note and hold it while pressing the Del key to delete.

Editing
With the Left Mouse button:

1. Click and hold on a note to see the Pitch (note number) and the Attack offset of the selected 
note.

Then:
2. Move    vertically to change pitch. 



The note is triggered when the pitch is changed.

3. Move horizontally to change the start point of the note.
Releasing the mouse button plays the notes with the current parameters.

With the Right Mouse button:
1. Click and hold on a note to see the Velocity and the Release offset of the selected note.

Then:
2. Move    vertically to change velocity

3. Move horizontally to change the end point (length) of the note

4. Releasing the mouse button plays the note with the current parameters.

Fine adjusting
1. Press the left mouse button and use the left/right arrow keys to adjust Attack Offset in one tick 

resolution. 
The up down arrow keys changes pitch.

2. Press the right mouse button and use the left/right arrow keys to adjust Release Offset in one tick
resolution. 
The up/down arrow keys changes velocity.



Roll view - Drum staves

If the current staff has a percussion clef, the Drum type of Roll View will be opened.

The Drum type has a column with the drum names beside the vertical keyboard.

Roll View shows MIDI note events in a Pitch/Time Grid.

The time grid is determined by the current beat-resolution, and is changed by pressing the number keys. 

The Roll view Time Grid and the Ruler are linked and always shows the same resolution.

Roll View offer note entry and editing of note parameters using the mouse:

Note entry
Press Shift and click with the left mouse button in the beat and position you want the note placed.

When the mouse button is released the note is played for confirmation.

The note parameters defaults to:

· Length Current beat-division - 8 ticks

· Attack offset 0

· Release offset -8

· Velocity 64

If you move the note while pressing the left mouse button the note is triggered when the pitch (= drum 
sound) is changed.

Deleting a note
Click on a note and hold it while pressing the Del key to delete.

Editing
With the Left Mouse button:

1. Click and hold on a note.
The colour of the selected note changes to red. 
The Pitch (note number) and the Attack offset of the selected note is displayed over the grid.



Then:
2. Move    vertically to change pitch (= drum sound). 

The sound is triggered when the pitch is changed.

3. Move horizontally to change the start point of the note.
Releasing the mouse button plays the notes with the current parameters.

With the Right Mouse button:
1. Click and hold on a note. 

The colour of the selected note changes to red. 
The Velocity and the Release offset of the selected note is displayed over the grid..

Then:
2. Move    vertically to change velocity



3. Move horizontally to change the end point (length) of the note

4. Releasing the mouse button plays the note with the current parameters.

Fine adjusting
1. Press the left mouse button and use the left/right arrow keys to adjust Attack Offset in one tick 

resolution. 
The up down arrow keys changes pitch.

2. Press the right mouse button and use the left/right arrow keys to
adjust Release Offset in one tick resolution. 
The up/down arrow keys changes velocity.



Drum Settings

The output parameters of each drum sound can be controlled with the pop-up mixer module:

The Drum Settings module pops up by clicking with the left mouse button on any name in the drum 
names column.

Click on another drum name in the column to change the active drum sound.

The parameters are Volume, Pan, Reverb send and Tuning (in half-note steps). 

The Knobs are turned by pointing to the line on the knob - click - hold and drag around the knob.

NOTE
· The Volume, Pan and Reverb send settings are depending on the Master Settings on the drum 

channel(s). 

· These settings are controlled on the Main Mixer.

· The Volume and Reverb settings on each individual drum can only be less than the master 
setting.

· Master Pan should be set to Center to allow individual Pan to cover the full range.

· If the Master Pan is set to the full left (or right) position, individual pan will be restricted to work 
only within the range between center and full left (or right).



Tempo
The tempo range is from 10 - 240. 

Basic tempo is set with the Tempo slider on the Options    menu.

Tempo change controller events can be inserted anywhere in the song in the bar-graph window.



Bender
Musicator GS calculates the MIDI values between 0 - 16384 into cents, the musical term for fine-tuning of
pitch. This makes the values easier to relate to their effect.

One cent is 1/100 half-step.

Bender events are shown in a bar-graph window.

NOTE # 1
The calculation is based on the Bend Range parameter and the Pitch bend messages. 

For correct cent display of the bender messages, set the Bender range to the desired resolution.

NOTE # 2
Some instruments do not respond to MIDI control over the Pitch Bend range. The GS instruments do 
respond.



After Touch
Musicator GS supports Channel Aftertouch only. Channel Aftertouch is the pressure applied to the keys 
when holding them 'after the touch'.

The available value range is from 0 - 127

Some keyboards supports individual pressure sensing for each key and some instruments assign this 
information to certain sound parameters. This is not supported in GS-instruments.

After Touch events are shown in a bar-graph window.



Program Change
Program change events can be inserted by numbers within the song.

These are set in a Controller window as a single event.



Other Controllers
Shows controller events of selected type in a bar-graph window.

Several controller types are available:

GS-Controllers

Defined MIDI Controllers

Un-defined Controllers

The available range is from 0 - 127



Overview 
Shows the bars and tracks in a linear fashion:

Overview allows you to select a range of bars and parts for editing or transformation of parameters.



Page View
Shows the page as printed.

Editing using the Mouse
1. The top system can be moved vertically by holding the left mouse button and moving the system 

up or down.

2. The distance from the left margin to the start of the system is the area where instrument names 
are written in the score. 
To adjust this distance place the mouse pointer between the instrument name area and the 
brackets on any staff.
Click and drag vertically to adjust.

3. The right margin can be adjusted by click and drag on the right end of any staff.

4. The distance between systems are adjusted by selecting any system under the first and dragging 
the system outline up or down. 



The distance between systems are common. Any system adjustment will apply to all systems on 
the page.

5. Titles can be moved using the mouse.
The Main, Sub and Reference titles can be moved vertically.
The Composer and Arranger names can be moved freely.

NOTE
The adjustments done on the Title Page affect the Title Page only.

The following pages are set by first turning to page 2 by pressing the PageDown key. The adjustments 
affecting the rest of the pages are done one any page following the title page. 

It is not possible to adjust individual pages within the score or within a part.

Each part however, can be set differently.

Related Topics:
The space between double systems, and the space above and below each staff are set with the System 
Dimension tool on the Toolbar.

'Margins and symbol sizes is selected from the Options    - Page Layout - Dimensions menu.

Instruments in the score is selected from the Options    - Page Layout - Instruments menu.

Titles and Names are set in the Options    - Page Layout - Names menu

The Page View can show the Score or a selected Part.

The Zoom factor can be changed from 10 - 400%.



Mixer 
A real-time mixer for control of Volume, Pan, (works on nearly all MIDI instruments), Reverb send, 
Chorus send and Sound control parameters (works on GS-instruments only) on each channel.

The sliders are moved with the mouse: Point - click - hold - drag.

Clicking on the arrows above and under the slider will increment/decrement in steps of one.

The Knobs are turned by pointing to the line on the knob - click - hold and drag around the knob.

NOTE
The Mixer settings are stored with each song file.

The Mixer movements are not recorded in this version of Musicator GS.

However, all the mixer parameters can be selected as GS- controllers and drawn with the mouse or 
edited using Musicator GS' powerful edit commands. 
This method actually offers far better, and smoother, control over these parameters than recording the 
slider and button movements.



Effects
The GS instruments have an Effects Processor offering 2 simultaneous effects: Reverb/Delay and 
Chorus/Flanger/Short delay.

The effects parameters can be controlled from Musicator GS' Effect Control Panel

The Effect Processor in the GS instruments have 8 presets for Reverb/Delay and 8 presets for 
Chorus/Flanger/Short Delay. 
The Effects Control lets you choose between these as well as changing the parameters in the current 
preset.

The Knobs are turned by pointing to the line on the knob - click - hold and drag around the knob.

NOTE
Selecting another preset resets the parameter values.
The current effects settings are stored with each song.

When exporting as a MIDI file, the Effect setting are stored as System Exclusive messages. These can be
read by some programs like the Windows media Player, but not all. 
MIDI Playback units like the Roland Sound Brush SB-55 reads and plays these messages.

WARNING
The 'To Chorus' and 'To Reverb' buttons feed back to each other, making it possible to drive the effects 
processor into saturation when turned up too far. This causes severe distortion and sounds like your 
amplification system is damaged.

Excessive feedback settings can also generate loud howling actually damaging your amplification system.

Be generally cautious with the effects settings - the rule the pro's live by is 'Less Is More'...



Instrument 
Shows the Instrument to choose from.

Selecting an Instrument opens a list of the available sounds (also called 'patches') in that instrument. 

Pointing to a sound on the list sends a Program Change to the selected Instrument, calling up that sound 
to be played from the currently selected part.

Related Topics:
Adding Instrument sound lists



Adding Instrument sound lists
The Instrument sound list is stored in a file with the extension .MOD. These can be modified or created by
the user.

To edit an Instrument sound list open the file ANY.MOD with Windows' Notepad or a similar plain text 
(ASCII) editor. 

Edit the list and save it under a new name using the Save As.. command.

The next time you start Musicator GS the file will be available from the Instruments Menu.

The format is:
Title

Bank_Program #_Name 

(The Underlines (_) used here represent space in the MOD file)

Example:
Roland Sound Canvas

0 0 Piano 1

0 1 Piano 2

0 2 Piano 3

0 3 Honky-tonk

0 4 E.Piano 1

8 4 Detuned EP 1

(Note a single space between thethat No Bank Number is written as -1. 0 is Bank # zero.)



Setup - Part 
For setting Instrument names, Clef, Play status (Normal/Mute/Solo), Playback Transpose and MIDI 
Channel assignments.

The Fields:
Part Musicator's internal part #. Can 

not be changed.

Name Instrument name. Automatically
entered when selecting an 
instrument from the Instrument 
List, but can be typed over.
The instrument name is also 
entered over the staff.

Clef Clef setting. 

Soprano, A= Alto, T= Tenor, B= 
Bass, D= Double (Piano), R= 
Rythm.

Mute M = Mute playback, S = Solo, - 
= Play
("Multiple Solo" is possible.)

Trans Transpose Playback, by a 
number of semitones.
Legal range is from -127..127

Chan Output Channel

Legal range is from 1..16

Setup - Channel 



The channel setup controls the following parameters:

Related Topics:
Bend range
Portamento
Poly/Mono status
GS Mute



Bend range
The range in semitones that the Pitch Bender will cover. 
The max. possible range on GS instruments is +/- 24 semitones (2 octaves).



Portamento
Enables portamento (glissando) between the notes played in the channel. Allowed input is 'Y' or 'N' for 
Yes/No to portamento

The Portamento Time (the sliding Rate of the glissando) is set with the - Portamento Time Parameter in 
the Other Controllers    Window.



Poly/Mono status
Poly mode is the default and normal setting, allowing more than one note to be played at a time on the 
selected channel.

Mono mode allows only one note at a time to be played, useful for solo instrument sounds like trumpet, 
flute etc.



GS Mute
Disables the channel on GS instruments. 

When using a SCC-1 card or a CM-300/500 module, which has no control panel, muting channels on the 
GS instrument allows these channels to be transmitted to the other instruments in the setup.



Setup - Drum 
On the Drum Setup menu all the system parameters relating to drum sounds are set.

The settings on the Drum Setup can be loaded and saved as a Drum Template.

Name The drum instrument name

MIDI Pitch The key on the MIDI instrument
the sound is assigned to.
The format allows using the - 
(minus) before the pitch to 
define any key in the scale.
Entering '+f' will be changed to 
'-g' when pressing Enter or 
moving out of the field.
Sharps or flats are not used in 
drum notation. 
If you prefer editing by MIDI 
note numbers rather than, pitch
you can open the Drum 
Templates files (having the 
extension .DRS) with a plain 
text editor such as Notepad. 



The MIDI pitches are registered
as note numbers in these files.

Map to Position The position in the staff, relative
to the middle staff line.:

Position:

The range is from -12 to 12 half
steps above /below the middle 
staff line.

Symbol The drum symbol can be one of
4 types:

Filled noteheads are commonly
used on drum sounds, the x-
head on cymbals and other 
percussion instruments.

Stem Up/Down Stem direction, can be up or 
down.

Group The beam group for the 
selected instrument. Beaming 
notes of related sounds 
together makes drum notation 
easier to read.
Up to 32 beam groups can be 
defined.
(This is in fact one for each 
possible drum note, resulting in
no beaming of drum notes.)

The Options Menu
MIDI/Metronome
Basic Tempo
Note Attributes
Beaming Parameters
Notation mode
Page View Control
Time Signature
Bars in system



Page Layout
Save Drum Template
Load Drum Template
Application Fonts



MIDI/Metronome

The MIDI/Metronome menu has several settings affecting how Musicator GS relates to MIDI settings:

Related Topics:
Paging
GS Mode
MIDI Thru
Multi-Channel recording
MIDI Sync
Metronome



Paging
Turning the pages while playing the MIDI data can be turned OFF.
For slow computers, this ensures that the turning of pages does not take up too much of the system's 
performance which might influence the timing of MIDI playback.

This is depending on many parameters, such as CPU speed, amount of available memory, video 
performance, screen size, general system configuration, score size, density of notes and controllers and 
more.

If there are glitches in playback, turning paging off is the first thing to do to increase the available 
performance resources.



GS Mode
Checking this box sends a MIDI System Exclusive Message that puts the instrument in GS Mode. 

This message is sent:

1. If checked, when Musicator is loaded

2. When the box is checked after being un-checked
(If you connect a GS instrument to the computer when Musicator GS is already running, this 
insures that the instrument is set in GS mode.

This works on Roland GS instrument only.



MIDI Thru
When MIDI Thru is checked, the signals received form MIDI IN is transmitted to MIDI OUT. 

If you are using a keyboard controller and a sound card/module MIDI Thru must be checked to hear what 
you are playing.

If you are using a keyboard instrument with an internal sound source you might want to do one of two 
things:

1. Set the instrument in Local OFF (preferred)

2. Set MIDI Thru in Musicator GS to OFF

This prevents the instrument from doubling the notes played, receiving information both from MIDI IN and 
from its own keyboard.
Then the numbers of available voices are reduced.

Re-channelizing
If you set your instrument's MIDI transmit channel to 1, Musicator GS will automatically change both input 
and Thru output channel according to the part settings.

If you move the Ruler to a staff/part assigned to channel # 2, Musicator GS will monitor, record and play 
back on channel #.

No changes in transmit channel is necessary on your instrument.

If your instrument transmits on a different channel, Musicator GS will record or step-enter on that channel,
the part selected is not considered.



Multi-Channel recording
If you record from a source transmitting on multiple MIDI channels always place the Ruler over the part 
using channel 1. 

If you don't, the MIDI data transmitted on Channel 1 will be re-channelized to whatever the channel of the 
part where the Ruler were placed.



MIDI Sync 
MIDI Sync Internal
Start/Stop and Tempo are controlled by Musicator GS' own tempo settings.

MIDI Sync Out
For controlling external units like drum machines, sequencers etc. Musicator GS can transmit Start/Stop, 
Clock and Song Position Pointer while playing/recording.

This function is turned ON/OFF by checking/unchecking the MIDI Sync Out checkbox



Metronome 
The metronome in Musicator GS uses a connected instrument to generate the metronome sounds.

The built-in sound of some interfaces or the PC-speaker is not used.

Active
Turns on the metronome to sound during recording.

The Metronome can also be turned on/off by pressing the  button on the Toolbar.
Lead-in count
Turns on the metronome to sound one bar before recording starts.
NOTE
The metronome will only sound during Recording, never during playback.
Channel
Any MIDI channel (1 - 16) can be set to receive the metronome signal.
Downbeat pitch
The note to be played on the downbeat.
Downbeat velocity
The velocity value (loudness) of the downbeat note
Beat pitch
The note to be played on the beats.
Beat velocity
The velocity value (loudness) of the beat notes.



Basic Tempo
Basic Tempo is adjusted with the slider.

Clicking on the left or right arrow buttons decreases/increases the tempo by a value of one BPM.

Clicking between the slider button and an arrow button changes the tempo by a value of 10 BPM.

To make Tempo changes in a song, insert tempo events in the graphic Tempo Control window.



Note Attributes
This control box contain tools for changing notation details, like flip stem direction, beaming, grace notes 
and enharmonic transform.

Shortcut: Press the right mouse button in the Notation window.

To Change:
Related Topics:

Grace notes
Beaming
Flip stem direction
Enharmonic transforms



Grace notes
Pressing the Grace button transforms the selected notes to grace notes.

NOTE
This command works only on chords.

· If there is only one note on a stem it can not be transformed to a grace note.

· If you select all notes on a stem, all but the latest played note will be transformed to grace notes.

· The selected notes on a stem will all be transformed, the notes not selected will remain normal 
notes.

· Selecting grace notes will reset these to normal notes.

When transforming notes to grace notes the MIDI timing of the notes determines the order in which they 
appear.

· For music recorded in real time no editing of the timing is necessary (if the performance is as 
desired..).

· For music entered with the mouse or in step-time, manual editing of the notes will be necessary.

Editing the start time of notes is done by changing the attack offset of the notes as described in Roll View.

To make separate notes into grace notes:

· Select the notes and re-transcribe to a lower resolution (1/8 notes in this example) covering the 
target note group:

· Press the Grace button.



Beaming
1. Select the notes you want to break apart from the beamed group.

2. Press the Beam button.

3. Pressing the Beam button again re-joins the selected notes to the beamed group.

4. If the beaming is between 16th, 32nd or 64th notes, there are more than one beam line: 

· Re-beaming connects one beam at a time



Flip stem direction
Single notes (notes not in a group):

· Select the note you want to flip.

· Press the Flip button.

Beamed group:
· Select the group

or 
· select the first and highest note in the group.

· Press the Flip button.



Enharmonic transforms
Enharmonic #
This command transforms the selected flat notes to their enharmonic equivalent sharp notes. 

Enharmonic b
This command transforms the selected sharp notes to their enharmonic equivalent flat notes. 



Beaming Parameters

Minimum beam angle
The minimum allowed beam angle can be set from 0 to 45 degrees.

Maximum beam angle
The maximum allowed beam angle can be set from 0 to 45 degrees.

Setting max. and min to the same value gives straight beams only.

Minimum pitch interval for beams to slant
The minimum musical interval for slanted beams to occur. 
The range is 0 to 45 note steps.

Minimum stem length in pixels
Minimum stem length can be set to be between 8 and 25 pixels in the Notation Window.

Reference measurements:
· The white space between two staff lines is 5 pixels high.

· A staff is 25 pixels high.



Notation mode

The Notation Window can be configured in various ways.

There are two very different display modes:

Related Topics:
Normal Width
Fit Window Width
Spacing
Bars pr system in Fit Window mode



Normal Width
The Normal Width setting is the working view, showing the correct placement of notes and symbols.

The horizontal proportions in Page View and printout are the same as in Normal.

The actual system width is set in the Page Layout menu.



Fit Window Width
The Fit Window width setting scales the system width to fit inside the Notation window, regardless the 
width of the window.

This mode is practical when using Notation together with Roll View and Controller View for editing MIDI 
parameters.



Spacing
Musicator GS' automatic spacing can be calculated in three ways:

Time Proportional
Strictly time proportional - the note duration is an exact division of the bar/notevalue: 

· a 1/2 note occupies 1/2 of the width of a bar, 

· a 1/4 note occupies 1/4 of the width of a bar, 

· a 1/8 note occupies 1/8 of the width of a bar

· etc.

Screen
The space between notes is calculated with dense areas given more space for improved appearance and
increased readability.

Only the staves on the screen are considered

Score
The space between notes is calculated with dense areas given more space for improved appearance and
increased readability.

All the staves in the score are considered.

Manual Spacing
Spacing can also be adjusted locally, using the mouse.

See Topics - Note Editing - Note Spacing.



Bars pr system in Fit Window mode
1 to 6 bars can be displayed.

This setting also affects the number of bars shown in Roll View.

Hide slurs
Slurs can be hidden to speed up re-drawing of the screen. 



Page View Control

NOTE
The Page View Control box can only be opened when the Page View Window is open.

You can also open the Page View Control box by pressing the right mouse button when the mouse 
pointer is in the Page View window.

Related Topics:
ZOOM
View
Add/Remove system



ZOOM

· Pressing the arrow button beside the zoom factor field opens the list of preset zoom values.

· Clicking on one of the values re-draws the Page View screen with the new zoom factor.

· You can also click - drag - release on the list.

· Any value between 20 - 400 can be typed in the zoom value field. 
Then click anywhere in the Page View window to re-draw with the new zoom factor.



View

In Page View you can view the score or any part.

· Click on the View arrow button to open the selection list.

· Clicking on one of the items on the list re-draws the Page View with the selected part (or score).

Score is always on top of the list.

If the list of parts is long, a scroll bar will appear on the right side of the selection list.

· You can also click - drag - release on the list.



Add/Remove system
Clicking on these buttons will add and remove, respectively, a system on the page.



Time Signature

Time Signatures are set in this menu.

They can be anything from 2/2 to 16/16.

From/Up To bar sets the bar range for the new time signature.

The settings only work on existing bars. To create new (empty) bars for a range, check the Create empty 
bars checkbox.

Related Topics:
Changing Time Signature
Pulse Pattern



Changing Time Signature
You can not freely change time signature in bars containing music. 

Possible changes:
· It is possible to reduce the numbers of beats in bar if the beats are empty, and in the end of the 

bar.

· If you have notes in the 3 first beats only of a 4/4 bar, you can change the time signature to 3/4.

· If you have notes in the 3 last beats only of a 4/4 bar, you can not change the time signature to 
3/4.

· Ii is possible to extend the time signature, for example to change time signature from 3/4 to 4/4. 
The last beat will be empty - notes in the following bar will not be moved across the new barline.

CLUE
To avoid problems, set the time signature before you record or enter music.



Pulse Pattern
Sets the beat/pulse pattern (beam grouping) in the selected bars:

Example:
To create a beam pattern in 6/8 time grouping pairs of    1/8 notes as in the first bar:

1. Click and hold the left mouse button above and before the first stem.

2. Drag the pointer past the last stem you want included in the new beaming group.

3. Release the mouse pointer.

4. Repeat for the next two beats.

To create a beam pattern in 6/8 time grouping three 1/8 notes as in the second bar:

1. Click and hold the left mouse button above and before the first stem.

2. Drag the pointer past the last stem you want included in the new beaming group.

3. Release the mouse pointer.

4. Repeat for the next beat.



Bars in system

The number of bars in a system can be set from 1 to 8 for a specified range of bars.

The settings only work on existing bars. To create new (empty) bars for a range, check the Create empty 
bars checkbox.

Selection
The number of bars can be set to affect all elements, or differently for the score and each individual part 
printout.

Related Topics:
Parts



Parts
The Notation window always shows a selection of the score. 
A part can only be viewed in full page mode in the Page View window.

The numbers of bars for each part therefore affects Page View and Part printouts only.

Clicking on the arrow to the right in the Selection field opens the selection list:

Choose the item you like by point and click or by click-drag -release.



Page Layout
Instruments, margins, instrument name area length, separate size scaling for score and parts, titles and 
credits are set on this menu:

Related Topics:
Dimensions:
Names
Instruments in the score



Dimensions:
Score Margins

Top Margin The distance between the top of the paper and the Title/Staves 
area.

Left Margin The distance between the left side of the paper and the 
Instrument Name/Staves area.

Instrument 
Name length

The area where the instrument names are printed.

System 
width

The width of the staff area. 
For printing in landscape mode a width of about 10" (25.4) cm is 
normal.
For printing in portrait mode a width of about 6.5" (16.5) cm is 
normal.
This setting also affects the System width in the Notation window.

cm/in Measurement units can be switched between centimeters or 
inches.

Part margins:
Left The distance between the left side of the paper and the Staves 

area.

Width The width of the staff area. 
For printing in landscape mode a width of about 10" (25.4) cm is 
normal.
For printing in portrait mode a width of about 6.5" (16.5) cm is 
normal.

Top The distance between the top of the paper and the Title/Staves 
area.

cm/in Measurement units can be switched between centimeters or 
inches.

Print Sizes Print sizes can be set individually for the score and the parts.
The settings can be between 20 and 400.

Names
The Main Title, the Sub Title, Composer and Arranger all appears on top of the first score page and the 
first of the part pages only.

The Ref. title appears on the successive pages

The Instrument names are printed on all score pages and part pages.

The names in the fields can be up to 38 characters long.

All Title fields are automatically centred on the page, but can be moved freely up and down by using the 
mouse on the Page View screen.

The part Instrument name, composer and arranger fields can be freely moved by using the mouse on the 
Page View screen.

The fonts for the names and titles can be changed form the Options Application Fonts menu.



Instruments in the score 

 
Pressing this button opens the selection window for parts and the order of the parts in the score:

By default the parts are listed in the left score list window in the order of their MIDI channels. 

To remove a part from the score select a part with the mouse pointer and press the Remove button.

To insert a part select one of the parts on the Additional parts list and press the Insert button.

The new part will be inserted below the part selected on the Score list.



Save Drum Template
Saves the current Drum Setup as a Drum Template to a file.

32 drums can be defined

The name can be up to 22 characters long.

The Drum Templates are saved in a file with the *.DRS extension.

Musicator GS assigns a unique number to these files as you save new templates. This allows longer, 
more descriptive names as they are    located inside the file. 



Load Drum Template
Loads a Drum Template from disk to the Drum Setup.

NOTE
The current Drum Setup is replaced when another is loaded. 

If you have made changes to the current Drum Setup, save it first as a new or updated Drum Template if 
you want to keep the changes.



Application Fonts
There are several text elements involved in Musicator GS printouts. 

You can choose which of your system's installed fonts to use in each text element.

The text elements are:
· Main Title

· Sub Title

· Misc. Font

· Instrument Name - Score

· Chord Font

The Misc. Font is used for all these text elements:
· Composer

· Arranger

· Reference title

· Instrument Name - Part

· Page number

Change
Pressing the change button calls Windows' standard font selection menu, giving access to all fonts 
installed on your system.



Help
Musicator GS on-line Help.

Related Topics:
Using Help



Using Help
Some words are Green. Click on the green word to find out more about that term.

Other times a green word makes you Jump to a related Topic.



Using the Toolbar

The Toolbar provides quick mouse access to the functions most often used in Musicator GS.

The Toolbar is divided in sections:

Related Topics:
Current Bar/Part display
MIDI IN Enable
Metronome on/off
Transport
Mouse Pointers
Graphic symbols
System Dimensions
Transcription Tools
Quantize MIDI
Mixer
Instrument



Current Bar/Part display

The bar field shows the bar number where the Ruler is placed.
The Part field shows the currently selected part number.



MIDI IN Enable

Pressing this button enables MIDI Input for Step Recording or Real-time Recording from a MIDI 
instrument.



Metronome on/off

Pressing the Metronome button turns the Metronome sound on or off.
The metronome sound is set on the Options    - MIDI/Metronome Menu.



Transport

The transport buttons starts playback, record and control "wind" functions. 
They operate like the buttons on a tape recorder.

Play, starts playback from the current bar.
Stop playback
Go To Start
Go To End
Record



Mouse Pointers
 

Selects different Mouse Pointers for selecting, note entry and voice editing.

This is the Normal Mouse Pointer. Click on a staff to change active staff. 
Press the left mouse button and drag to select an area. The selected area is inverted.
The selected area can be cut, copied or moved, as well as processed with the Transcription Tools and the
Transform options.

Note entry pointer. Pressing this button changes the pointer to a notehead in a wire cross to assist in 
aligning new notes with existing notes

Clicking on this button makes the Arrow Pointer a line drawing tool and opens the:

Related Topics:
Voice Control Tools



Voice Control Tools

Select Voice 1, 2, 3, 4

Select stem direction of a voice: Up, Down, Variable, Reset
NOTE
When the Voice Control Toolbox is open, Step Entry of notes will be assigned to the currently selected 
voice and stem direction.
Voice assign tools:

Split between double system

Split between 1.Voice & 2. Voice

Assign notes in "lasso" to the selected voice

Assign notes below line to next voice
OPERATION:

1. Draw dividing line with the mouse between notes to be assigned to new voices.

2. Select voice number.

3. Select stem direction.

4. Press the Voice assign tool to apply the new voice assignment.

5. Pressing Reset resets all voice assignments in the current bar 



Graphic symbols 
 

Clicking this button opens the Graphic symbols menu.
A list window containing the various symbol groups is opened.
Selecting a symbol group opens a sub-window with the symbols in that group.

Selecting a symbol changes the mouse pointer to the selected symbol which can be clicked in place 
anywhere.
There are three types of symbols that are different:

Related Topics:
Clefs and ottavas
Repeat markings
Bar lines/Repeats
Alignment
Slurs
Text
Chord symbols
User
Deleting symbols



Clefs and ottavas
Initial Clefs are set from the Setup - Parts menu.

Clefs from the Graphic symbol menu can also be inserted in a staff.

NOTE
When clefs are changed or inserted, the existing music on the staff is transposed.



Repeat markings
The 'jump' symbols (Dal Segno etc.) in row 3 from the top, are global.    They are not tied to a particular 
staff and will be printed on each part as well as the score.

Always place global symbols on the 1st (upper) staff.
This can be done in any of the 3 screen setups.

Repeat endings
When entering Repeat Endings the dialog box pops up:

· The bracket can be open or terminated.

· Bracket length is set in bars.

· The text in the field will appear in the Score and all printed parts.



Bar lines/Repeats
Bar lines are also global, but can be entered from any part.

Place the symbol cursor to the left of the existing bar line to set.



Alignment
Symbols are always connected to the musical position in the staff where they are placed.

If you change the horizontal dimensions by adding/removing bars in a system, the graphic symbols will 
move along with the music they are related to.



Slurs
The Slur tool is selected from the trills etc. section in row #6. 

Slurs are drawn with the mouse - click and hold the left mouse button while drawing the slur.

Musicator GS then immediately scans the shape of the slur when you finish drawing, and smoothes the 
curve.



Text
Text can be written anywhere in the score.

Press the 'I' button for the cursor.

Fonts
Pressing the 'Fonts' button opens the Style Group Select dialog.

You can define a new style consisting of any font and size available in your Windows environment, and 
your choice of alignment.

NOTE
If you change a Style, all text already typed with that style will be changed globally. 

Alignment
When typing lyrics, Centered alignment will place the center of the word or syllable directly under the 
referred note.

Musical position
You can use the TAB key to jump between note positions in the music.
This makes it easier to align lyrics to notation.



Chord symbols
Chord symbols can be entered with the Chord symbols tool.

You can enter complicated chords like 'Cm7-9/D#9add6'. 

NOTE
'#' and 'b' placed adjacent to a letter are interpreted as attributes to the key, not to the following number:

D#9 is interpreted as D sharp, not as an D with augmented 9.
Use the + sign for augmented intervals.

When transposing in Overview the chords are also transposed.



User
The User symbols group consists of these symbols:

They can be entered anywhere, but have no musical function related to Musicator GS' musical 
knowledge and tools.
Musicator GS relates to these symbols as pure graphics.
They are intended to be used for rest cues, replacing rests in bars where phrases in another part could be
notated as the rests in another part(s).
Accidentals can also be used for explicit notation, where a musician might be in doubt whether an 
accidental in a preceding bar is still valid or not.



Deleting symbols
To delete a symbol:

1. Select it with the mouse by marking an area covering the symbol

2. Press Delete.



System Dimensions 

Clicking this button opens the tools for adjusting the space over, between and below staves. 
NOTE
This setting determines the vertical    spacing between parts within the systems in the score.
The distance between score systems and part systems in part print is set directly on the Page View.

Operation:
1. Select active staff by clicking once.

2. Grab the staff and move up/down to increase the space over the staff. 

3. Grab the lines under the system and move the line up/down to adjust the area below staff. 

The cursor automatically changes to the Up/Down arrow when placed within an adjustable area.



Transcription Tools

Re-Transcribe
Pressing the Re-Transcribe button is the same as choosing Re-Transcribe on the Transform Menu

Minimize Rests. 
Pressing the Minimize Rests button is the same as choosing Minimize Rests on the Transform Menu

One Voice
Pressing the One Voice button is the same as choosing One Voice on the Transform Menu



Quantize MIDI
 

Quantize MIDI data of the selected notes.
Pressing the Quantize MIDI button is the same as choosing Quantize MIDI on the Transform Menu.



Mixer

Pressing this button opens the mixer
Shortcut for selecting the Mixer from the Windows Menu



Instrument

Pressing this button is a shortcut for selecting the last Instrument previously selected from the Windows 
Menu.
NOTE
If you want to select a different Instrument using another list of sounds, you have to go via the Windows 
Instrument menu.



Shorcuts and Keyboard Commands
To make Musicator GS faster and easier to use there are several shortcuts and keyboard commands 
available:

Related Topics:
General
In the Notation Window
In the Overview Window
In the Roll View Window
In the Page View Window
On the Mixer
On the Part Setup menu



General
Pressing Home goes to the first bar in the song.

Pressing End goes to the last bar in the song.

Pressing the Space bar starts and stops playback and recording.

Pressing 'R' starts Recording.

Pressing Cntrl + M mutes the current Part in Playback.

Pressing Cntrl + S Solos the current Part in Playback. 



In the Notation Window
Pressing the right mouse button opens the Note Attributes toolbox.

The Mouse can be used to mark an area and moving/copying the selected notes or symbols.



In the Overview Window
Clicking with the mouse in the Part Name area selects all bars in the part.

Clik and drag several names to select several parts.

Clicking with the right mouse button in the Names area opens the Part Setup menu.



In the Roll View Window
In Roll View - Drums clicking the left mouse button in the Drum Names area opens the Drum Mixer 
Module.

Clicking the right mouse button in the Drum Names area opens the Drum Setup Menu.



In the Page View Window
Pressing the right mouse button in the Page View window opens the Page View Control Toolbox.



On the Mixer
Clicking the right mouse button in the Mixer opens the Effects Control. 



On the Part Setup menu
Clicking the right mouse button in the Part Setup Menu opens the Channel Setup Menu.



Basic functions
In Musicator GS all MIDI Controllers (none-note events) are shown in a graphic window. The Controller 
events are shown as bar-graphs with .

When the mouse pointer is moved inside the controller display area, the Value and Time fields changes, 
showing the parameters for the current position.

When a single event is selected for editing, it is coloured red, and the exact value and timing is shown in 
the numerical fields.

When a range is selected for editing, the area is inverted.

Value
All types of Controllers have a range from 0..127 except the Bender.

The Bender events are shown in Cents. 
The range depends on the Bend Range for the current channel set in the Options - Channel Setup menu.

Time
The cursor on the Ruler shows the beat and beat-division.

The Time field shows exact time in Beat and Ticks.

Related Topics:
The Number of Bars in the Controller Window



The Number of Bars in the Controller Window
The number of Bars in the Controller Window is depending on the current status of the Notation Window 
in that User Setup:

· If you have a Notation Window in Normal mode, the number of bars in the Controller Window will 
follow the settings on the Options -Bars in System -menu.

As you flip through pages containing different number of bars, the Controller Window will 
automatically be scaled to show all the bars on the current page.

· If you have a Notation Window in Fit Window mode, the number of bars in the Controller Window 
will follow the 'Number of bars' setting on the Options - Notation Mode - menu.

The number of bars in this mode is fixed, and not related to individual pages.



Editing of Single Controller Events
Setting a single Controller event
Editing a single Controller event



Setting a single Controller event
To set a single controller event:

1. Move the mouse pointer to the position where you want to insert the event. 
The Value and Time fields show the parameters.

2. Click the Right mouse button to set the Controller event.

Related Topics:
Shortcuts for setting preset values:



Shortcuts for setting preset values:
1. Move the mouse pointer to the time-point where you want to insert the event. 

2. Press the key for one of the preset values: 

· the 'x' key for the Maximum value

· the 'd' key for the Middle value

· the 'n' key for the Minimum value

The value is inserted.



Editing a single Controller event
Selecting a Controller event:

· Click the right mouse button on the Ruler below the controller events

or

· Press the 'F' key for Find.

The nearest controller event is marked in red.

· The Left/Right arrow button changes selection by jumping to the closest left or right controller 
event.

Editing the Value
· Press    the up/down arrows to change the value.

The new event value is displayed in the numeric field as you press the arrow keys.

Editing the Timing
· Press and Hold the Shift key

· Use the Left/Right arrow keys to change timing.

The new timing is displayed in the numeric field as you press the arrow keys.

Delete an event
To delete a single Controller event:

· Press the Delete key to delete the event.



Other Controllers
Musicator GS offers a list of the different controllers, opened from the list box in the Controller window.

The list is organized in 3 sections:

Related Topics:
GS Controllers
Defined MIDI Controllers
Un-defined Controllers
Setting a single Controller event
Editing a single Controller event
Deleting a single Controller event



GS Controllers
The GS format specifies a number of Controllers for certain parameters.

These are:

· Vibrato rate

· Vibrato depth

· Vibrato delay

· TVF cutoff

· TVF resonance

· Env. Attack time

· Env. Decay time

· Env. Release time



Defined MIDI Controllers
These Control parameters, according to the MIDI specification, are generally available on most MIDI 
instruments:

· Aftertouch

· Modulation

· Portamento Time

· Volume

· Panning

· Expression

· Pedal

· Portamento

· Sostenuto

· Soft

· Reverb send

· Chorus send



Un-defined Controllers
These Controllers are not defined by the MIDI specification to any parameters. They are listed by Control 
number only in the list.



Setting a single Controller event
1. Open the list by pressing the arrow button

2. Select a Controller from the list.

3. Move the mouse pointer to the position where you want to insert the event. 
The parameter value is displayed in the Value field and the exact timing in the Time field.

4. Click the right mouse button when the desired value is displayed to set the Controller event.

Related Topics:
Shortcuts for setting preset values:



Shortcuts for setting preset values:
1. Open the list by pressing the arrow button

2. Select a Control parameter from the list.

3. Move the mouse pointer to the position where you want to insert the event. 

4. Preset values are: 

· the 'x' key for the Max value

· the 'd' key for the Mid value

· the 'n' key for the Minimum value

Press one of these keys to insert the value.



Editing a single Controller event
· If necessary, select the desired Control parameter from the list.

· Press and hold the right mouse button on the Ruler below the controller events.

or

· Press the 'F' key for Find.

The nearest controller event found is marked in red.

· The Left/Right arrow button changes selection by jumping to the closest left or right controller 
event.

Editing the Value
· Press    the up/down arrows to change the value.

The new event value is displayed in the numeric field as you press the arrow keys.

Editing the Timing
· Press and Hold the Shift key

· Use the Left/Right arrow keys to change timing.

The new timing is displayed in the numeric field as you press the arrow keys.



Deleting a single Controller event
· If necessary, select the desired Control parameter from the list.

· Press and hold the right mouse button on the Ruler below the controller events.

or

· Press the 'F' key for Find.

The nearest controller event found is marked in red.

· The Left/Right arrow button changes selection by jumping to the closest left or right controller 
event.

· Press the Delete key to delete the event.



If you encounter problems, how to solve them
As Musicator GS will be running on many different computers, with different MIDI interfaces, MIDI 
instruments and users, problems will occur.

The first thing to do is to check your documentation of the various products in use. 

If no solution is found consult your dealer or distributor.

If you have a modem, there are many bulletin boards and networks where other users can be reached, 
like CompuServe, Genie, PAN etc.

A lot of knowledge and experience is gathered in these forums and turnaround is fast, usually within the 
next day.

Some general problems (and solutions) are discussed below:

Related Topics:
System Requirements
MIDI Interface installation and setup
General Performance
Font installation
Printing



System Requirements
Musicator GS requires a system running Windows 3.1 or higher.

Recommended amount of RAM is 4 Megabytes.

As with all Windows Applications, a fast CPU, a lot of RAM, a big screen with a graphic accelerator card 
etc. makes everything work smoother.



MIDI Interface installation and setup
If you can use the Windows Media Player to play back MIDI files on your system, Musicator GS will install
and perform properly.

If you do not have the Media Player installed, refer to your Windows documentation and install Media 
Player, MIDI Drivers and the MIDI Mapper first.

Then install Musicator GS.

Be aware that some game cards with MIDI does not support MIDI Thru while recording or Playback. 
Some interfaces can not play back while recording.

If you encounter these problems, consult your dealer, or the manufacturer.

Roland cards (MPU-IPC, SCC-1) as well as enhanced MPU-compatible    MIDI interface cards like Music 
Quest, do not have these problems.



General Performance
If you have problems with playback during screen-redrawing there are several ways of fixing the problem, 
listed by price:

1. Turn off Paging (free)

2. Buy a graphic accelerator card

3. Buy a faster computer

4. Buy a faster computer and a graphic accelerator card



Font installation
Musicator GS comes with its own Musical font in both TrueType and Adobe Type 1 (ATM) format.

If you already are using ATM a PostScript printer, the Type 1 font is recommended.

See your ATM documentation fro installation of Type 1 fonts.

If you are not using ATM, and do not have a PostScript printer, the TrueType font is required.

Installation of the font is done from the Windows Control Panel - Fonts, using the ADD command.

For more information see your Windows documentation.

NOTE
When installing a Type 1 font, you will have to restart Windows for the change to be noticed by ATM.

If you have enabled TrueType fonts, and only add the Musicator font to your existing repertoire, restartin 
Windows is not neccessary.
(However, if TrueType is not enabled, Windows will prompt you for a restart when you enable it.)



Printing
One thing to be aware of when printing both score and parts in one session is that they have to be in the 
same page format and orientation.

The Printer Setup defines these settins and can not be overriden by Musicator GS during a print session.

If you want to print the score in landscape format and the parts in portrait, you will have to change Print 
Setup for the different formats, Then print the score in one session, parts in another.



This might change in the future, in an updated or enhanced version.



If notes are placed far above or below the current staff, you might experienca that th pointer 'jumps' to the 
staff over or under the one you intend to work on when you click the mouse button..
To avoid this, press Shift and hold while pressing the mouse button.



This command re-draws the whole screen and is quite demanding on your system's computation power. 
If you have a fast 486 system, it will perform smoothly. On a 386SX it will be quite slow...



Default settings are stored in the file DEFAULT.MCT.
If you want to change the default settings, set up the staves, channels etc. as you like and then save the 
file under the name DEFAULT.MCT



A MIDI file is a standard file format defined by the International    MIDI Association (IMA) and the MIDI 
Manufacturers Association (MMA) and is supported by all current MIDI programs. A MIDI file contains all 
the performance data as well as Time Signature, tempo and channel/track names. Notation, text/lyrics 
and musical symbols are currently not covered by    the MIDI file format.



System Exclusive (SysEx) is MIDI data specific for certain manufacturers and products.
The GS instruments and Musicator GS use SysEx for the effects control settings only.



A MIDI file is a standard file format defined by the International    MIDI Association (IMA) and the MIDI 
Manufacturers Association (MMA) and is supported by all current MIDI programs. 
A MIDI file contains all the performance data as well as Time Signature, tempo and channel/track names. 
Notation, text/lyrics and musical symbols are currently not covered by the MIDI file format



Current position is selected by clicking the mouse. In the score window, move the mouse pointer to the 
desired    point (beat, subdivision) and click on the ruler. The pink bar will lock to that position. Then go to 
the Edit menu to select the Paste command.



The current position is where the cursor on the Ruler is located. 



A tick is a 480th of a beat.



The Current beat resolution is selected with the number keys and indicated on the Ruler.
Pressing the number '4' in 4/4 time divides the beat in 4 giving 1/16th notes as the currently smallest 
possible notevalue



If you need various windows setups for different types of sessions you can have several configuration 
files. The catch is that Musicator GS recognises only the    MUSIC.CNF file.    If you copy a MUSIC.CNF to
another file with a different name you can rename that file later to MUSIC.CNF before starting Musicator 
GS



For precise movement you can move in a big circle around the knob, while holding the mouse button. The
bigger the circle, the finer control.



For precise movement you can move in a big circle around the knob, while holding the mouse button. The
bigger the circle, the finer the control.



For precise movement you can move in a big circle around the knob, while holding the mouse button. The
bigger the circle, the finer control.



To select a part click on the staff in the Notation window, or on the Track in Overview.



GS Mode is the native mode of most Roland    GS instruments. 
Some instruments operate in several modes, like some of the E-series instruments.
Setting GS mode ON ensures that certain MIDI messages controlling sound parameters are received 
properly.



Existing bars are bars that already are created.
Musicator automatically creates bars as needed. Bars are created when    you record music in real time or
step. 
When you manually turn pages, empty bars are created to give room for the notes.
Two menu commands also optionally create empty bars: Time Signature (this one) and Bars in System.



Musicator creates bars as needed. Bars are created when    you record music in real time or step. 
When you manually turn pages empty bars are created.
Two menu commands also optionally create empty bars: Bars in System    (this one) and Time Signature.



The Drum Template contains all names and parameters that can be set on the Drum Setup menu.



You can edit the *.DRS files with a pure text editor such as Notepad.
The file contains the same fields as the Drum Setup menu. 
The only difference is that the MIDI pitch is numerical.



Some times clicking pops up a small window like this one, where you get additional information about the 
term.
Click in this window to close it.



The Current bar is the bar where the Ruler is located.



A Voice is a sequence of tones on the staff. A staff can have several voices - polyphony - or a single voice
- monophony. In keyboard music each voice can also contain chords - which does not necessarily create 
polyphony. Musicator GS handles both kinds of voices.



The active staff is the staff directly below the Ruler.



Musical position is relative, depending on the density of music in the bar.
The absolute placement of the second beat in a bar will vary, according to the density in the music.



A Cent is a 1/100 half-note step.
If the Bend Range is +/- 2 half-tones the range in the Bender Window is +/- 200 Cents.




